COMPARING PERFORMANCE AND COST: DELL EMC POWEREDGE VRTX WITH
TWO DELL EMC POWEREDGE M630 SERVER NODES VS. A LEGACY SOLUTION
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Businesses using outdated servers for email, database, and file and print
workloads stand to benefit greatly by replacing them. The Dell EMC PowerEdge VRTX
with two Dell EMC PowerEdge M630 blade servers, both powered by the Intel Xeon
processor E5-2650 v3, can provide the performance, scalability, and high availability
your business needs to keep running and meet increased demand.

In the Principled Technologies labs, we simultaneously ran email, database, and
simulated file and print workloads in a VMware® vSphere® ESXi™ virtual environment
on the PowerEdge VRTX with two PowerEdge M630 server nodes configured in a high-
availability (HA) cluster. The VRTX performed more simultaneous work while requiring
less space and power, and provided a lower five-year TCO when compared with a legacy
disparate hardware solution.! Combining servers, networking, and shared storage into

an all-in-one solution, the PowerEdge VRTX can deliver big performance and savings.

Yn June 2013, Principled Technologies conducted testing comparing the performance of (1) the Dell PowerEdge VRTX with Dell PowerEdge M620
server nodes and (2) a legacy hardware solution. The results for the legacy solution that we cite in this report are from that earlier study. For more
details, see the report for that study, available at www.principledtechnologies.com/Dell/VRTX_performance_TCO 0713.pdf.
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GET BETTER PERFORMANCE WHILE USING LESS POWER

We compared performance, power consumption, space, and cost of running
typical office applications (email, database, and file/print server) on the following
solutions:

* A Dell EMC PowerEdge VRTX with two Dell EMC PowerEdge M630 server
nodes powered by the Intel Xeon processor E5-2650 v3, running VMware
vSphere 5.5 in a high-availability (HA) cluster configuration with four
Microsoft® Windows Server® 2012 R2 virtual machines (VMs) — one running
SQL Server® 2014, two running Exchange Server 2013, and one acting as a
file/print server.

* Alegacy disparate hardware solution consisting of three older HP tower
servers, a NETGEAR® switch, and an HP storage appliance. The legacy tower
servers ran bare metal instances of Windows Server 2012 with one running
SQL Server 2012, one running Exchange Server 2010, and one running as a
dedicated file/print server.

We ran three benchmarks simultaneously to stress the email, database, and file

and print applications all at once. The performance of the legacy hardware solution we
discuss in this report is from a June 2013 Principled Technologies study (available at

www.principledtechnologies.com/Dell/VRTX_performance TCO 0713.pdf).

When configuring the workloads for this study, we began by running workloads
identical to the ones in the previous study, and found that the PowerEdge VRTX had an
enormous amount of unused hardware capacity.

We then increased the load of each benchmark on the VRTX solution to reflect
the business growth that would occur in a typical company over three years. Note that
we did not increase the loads to a level that would push the VRTX to its limits. Rather,
we attempted to represent realistic gradual growth a company would observe. Under
the increased workload, the CPU utilization of the VRTX remained at levels that would
allow for even greater workloads as the company experienced further growth in the
future.

We also measured the power consumption of the PowerEdge VRTX and the
legacy solution while idle and during the simultaneous workloads. For detailed
configuration information about the solutions we tested, see Appendix A. For testing
details, including the increased workload parameters we used, see Appendix B. For

detailed test results, see Appendix C.
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Dell EMC PowerEdge VRTX with the Intel Xeon processor E5-2650 v3 optimized application
performance while reducing power consumption and providing headroom for future growth

Database performance

Figure 1: While running
simultaneous email,
database, and file and print
workloads, the Dell EMC
PowerEdge VRTX with two
Intel processor-powered
M®630 server nodes
supported more database
workload than the legacy
disparate hardware solution.

File and print performance

As Figure 1 shows, during our test running three workloads at the same time,
the Dell EMC PowerEdge VRTX with two Intel Xeon processor E5-2650 v3-powered Dell
EMC PowerEdge M630 server nodes achieved 2.9 times the database performance of
the legacy disparate hardware solution. This means the VRTX solution would be able to
produce at least 2.9 times as many database orders per minute. To simulate growth in
the overall business and number of employees, we decreased the think time of our
database benchmark on the M630s from the 300 milliseconds we ran on the legacy
solution to 100 milliseconds; this shorter think time represents more activity and stress

on the database.

Database performance while running three
simultaneous workloads
(higher numbers are better)

6,015

2,053

Orders per minute

Dell EMC PowerEdge VRTX Legacy HP tower solution

As Figure 2 shows, during our test running three workloads at the same time,
the PowerEdge VRTX with two Intel Xeon processor E5-2650 v3-powered Dell EMC
PowerEdge M630 server nodes achieved 4.8 times the simulated file and print
performance of the legacy disparate hardware solution. Again, to show the impact of
business growth, we increased the number of workers in our benchmark tool on the

M630s to represent more simulated users accessing file and print capabilities.
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File and print performance while running three
simultaneous workloads
Figure 2: While running (higher numbers are better)
simultaneous email,
database, and file and print
workloads, the Dell EMC
PowerEdge VRTX with two
Intel processor-powered
M630 server nodes
supported more file and
print workload than the

36.6

10PS

legacy disparate hardware 7.7
T
Dell EMC PowerEdge VRTX Legacy HP tower solution

Exchange performance
Along with growing the workloads to compensate for business growth since the
legacy systems testing, we upgraded from Exchange 2010 to Exchange 2013 and from
Microsoft Load Generator 2010 to LoadGen 2013. We also increased the number of

Exchange users from 500 to 750. Figure 3 shows our findings.

Number of users supported Latency in milliseconds
Dell EMC PowerEdge VRTX 750 1.8
Legacy disparate hardware solution 500 1.5
Figure 3: The Dell EMC PowerEdge VRTX reduced cabling complexity compared to the legacy disparate hardware

solution.

While we can’t directly compare the results from these two test scenarios due
to the differences between the two versions of Exchange, we can look at the number of
users and the latency, or response time, in milliseconds to learn about their relative
performance. We found that latencies remained roughly even on the newer solution
even with the increased number of users, and well within the average latency threshold
of 50 milliseconds that Microsoft sets. This means that the VTRX solution can support
one-and-a-half times as many email users while staying within an acceptable response

time.

Power consumption

The compact Intel Xeon processor E5-2650 v3-powered Dell EMC PowerEdge
M630 with Dell EMC PowerEdge VRTX not only supported more work than the legacy
tower solution, it also used significantly less power while under heavier load thanks to

Dell EMC’s performance-per-watt system power management policy. As Figure 4 shows,
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the M630 server nodes with VRTX used 41.5 percent less power while running our three
simultaneous workloads than the legacy disparate hardware solution did. This reduced

consumption can translate directly to savings.

Power consumption
(lower is better)

678.7

Figure 4: The Dell EMC
PowerEdge VRTX with two
Intel processor-powered
M®630 server nodes used less
power while running
simultaneous, more robust,
workloads than the legacy
disparate hardware solution
did.

396.8

Watts

Dell EMC PowerEdge VRTX Legacy HP tower solution

In our tests, we used a Dell EMC PowerEdge VRTX with only two servers
compared to the three physical servers in the legacy hardware solution. Adding server
nodes and more or faster drives to the shared storage may achieve greater performance
gains, though the current configuration still had plenty of room for growth. Additionally,
adding new application VMs to your VMware vSphere environment may give the Intel
Xeon processor E5-2650 v3-powered VRTX solution scalability and room to grow as the
demands of your business continue to increase. With a legacy disparate hardware
solution, achieving similar results may require purchasing additional servers that take up
more space and consume more power.

Reduced space and physical complexity

In addition to the extra space that legacy disparate hardware solutions
encompass, they often have a great deal of complexity when it comes to hardware
pieces and cabling. If your business’ location has premium square footage value,
accommodating your legacy solution can mean sacrificing precious space. The Dell EMC
PowerEdge VRTX is a compact all-in-one-solution that fits easily under a desk and uses
minimal cabling because the solution resides in one chassis.

Though the solution is unlikely to be in a server rack in a small or remote office,
we looked at the rack-equivalent space each solution would occupy to make a universal
size comparison. We found that the VRTX solution would fit into just 5U of rack-
equivalent space — a 70.6 percent reduction in the space that the legacy solution would

take up (a massive 17U).
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For each U of rack-equivalent space, the Dell EMC PowerEdge VRTX with two

Intel Xeon processor E5-2650 v3-powered Dell EMC PowerEdge M630 server nodes

delivered a whopping 10 times the database performance, in orders per minute, than

the legacy disparate hardware solution (see Figure 5).

Figure 5: The compact form
factor of the Dell EMC
PowerEdge VRTX means that,
with two Intel processor-
powered M630 server nodes,
it packs more performance
into less space than the
legacy disparate hardware

OPM per U

Database performance/U of rack-equivalent space

1,203.0

120.8
solution.
| B
Dell EMC PowerEdge VRTX Legacy HP tower solution
As Figure 6 shows, regardless of the server node configuration, the VRTX
solution powered by the Intel Xeon processor E5 v3 family also used only 6 cables, 13
fewer than the legacy disparate hardware solution.
Dell EMC PowerEdge VRTX
Ethernet cables Power cables
Total by type 2 4
Total cables 6
Legacy disparate hardware solution
Ethernet cables Power cables
HP ProlLiant ML310 G5 2 1
HP ProlLiant ML370 G5 2 1
HP ProLiant ML110 G6 2 1
NETGEAR ProSAFE® Smart Switch 1 1
Storage 6 2
Total by type 13 6
Total cables 19
Figure 6: The Dell EMC PowerEdge VRTX reduced cabling complexity compared to the legacy disparate hardware
solution.
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Dell EMC PowerEdge VRTX with two Dell EMC PowerEdge M630 server nodes offered more

performance per TCO dollar, lower five-year TCO, and a rapid ROI
While choosing to keep a legacy disparate hardware solution might seem

convenient and cost-effective, we found that purchasing and running the Dell EMC
PowerEdge VRTX with two Intel Xeon processor E5-2600 v3-powered Dell EMC

PowerEdge M630 server nodes could deliver as much as a 30.2 percent lower five-year

total cost of ownership (TCO) than continuing to use the legacy solution (see Figure 7).

Dell EMC PowerEdge VRTX with two M630 server nodes
saves up to $29,581 over 5 years
vs. legacy, disparate hardware solution
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Dell EMC PowerEdge VRTX with

$97,866
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two M630 server nodes
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M Year 2 costs
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Figure 7: The Dell EMC PowerEdge VRTX with two M630 server nodes could deliver a 30.2 percent lower
TCO over five years than continuing to use the legacy disparate hardware solution.

Savings in licensing, management, and support offset the larger acquisition
costs of the PowerEdge VRTX with two Intel Xeon processor E5-2600 v3-powered M630

server nodes. After five years, the VRTX solution is $29,581 less expensive, saving 30.2

percent (see Figure 8).

Dell EMC PowerEdge VRTX with two
M630 server nodes

Legacy disparate hardware solution

Acquisition cost $44,000 $5,102
Year 1 costs $4,857 $18,553
Year 2 costs $4,857 $18,553
Year 3 costs $4,857 $18,553
Year 4 costs $4,857 $18,553
Year 5 costs $4,857 $18,553
Total $68,286 $97,866

Figure 8: The Dell EMC PowerEdge VRTX with two M630 server nodes costs up to $29,581 less than the legacy solution after five

years. (Totals may not sum due to rounding.)
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Figure 9: The Dell
EMC PowerEdge

With the PowerEdge VRTX with two Intel Xeon processor E5-2600 v3-powered

M630 server nodes, we found that a business could achieve payback, or a return on

investment (ROI), in as little as 35 months (see Figures 9 and 10).

Payback in 35 months for Dell EMC PowerEdge VRTX with two
M630 server nodes vs. legacy, disparate hardware solution

VRTX with two Intel Z o
processor-powered g
M630 server nodes wn
can deliver payback >
in as little as 35
months.

0 6 12 18 24 30 36 42 48 54 60

Months
e==Dell EMC PowerEdge VRTX with two M630 server nodes | egacy

Dell EMC PowerEdge VRTX with two | Legacy disparate hardware .

Payback category & S . Difference
M630 server nodes solution

One-time initial investment $44,000 $5,102 $38,898
Monthly cost $405 $1,546 $1,141

Payback period

$38,898 + $1,141 = 35 months

Figure 10: The Dell EMC PowerEdge VRTX with two M630 server nodes can pay back your investment in 35 months, so by the
35th month, the return of investment is complete.

Comparing performance and cost: Dell EMC PowerEdge VRTX with

Using the calculations from our TCO analysis, we found that the PowerEdge

VRTX with two Intel Xeon processor E5-2600 v3-powered PowerEdge M630 server

nodes delivered 4.2 times as many database orders per minute per TCO dollar spent

(see Figure 11).

two Dell EMC PowerEdge M630 server nodes vs. a legacy solution
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Figure 11: The Dell EMC
PowerEdge VRTX with two Intel
processor-powered M630
server nodes delivered 4.2
times as many OPM per TCO
dollar. Higher numbers are
better.

Database performance/TCO dollar

0.09
J 5

Dell EMC PowerEdge VRTX with two Legacy HP tower solution
M630 server nodes

OPM per TCO dollar (higher is better)

For complete details and assumptions of our TCO analysis, see Appendix D.

ALL-IN-ONE MODULAR INFRASTRUCTURE

The Dell EMC PowerEdge VRTX solution with M-series server nodes is an all-in-
one solution designed to handle the performance needs of a small-to-medium business
or remote office. Here, we provide information about each of the components we used

as part of this solution.

About the Dell EMC PowerEdge VRTX

] HHHEE

o
s |

=i
| pead ]

Lilll““l b
AEE ¢ i
‘ll’}l.l‘illl = !]uwlﬂl

I
[ pea{l] [~ pon]

I

Dell EMC Dell EMC
PowerEdge PowerEdge
VRTX with 12 VRTX with 25
3.5-inch drives  2.5-inch drives

The Dell EMC PowerEdge VRTX is a compact, all-in-one solution in a 5U rack-
able tower chassis. Designed to be quiet under normal operating conditions, the
PowerEdge VRTX can be stowed under a desk in a small office without disrupting
conversations. The four bays in the VRTX house a variety of different compute nodes,
providing a space-saving alternative to four separate tower or rack servers. VRTX fans
and blowers, based on Dell EMC Energy Smart Technologies, deliver low power
consumption and use next-generation technologies to ensure they consume the least
possible amount of fresh air to cool the enclosure.

In addition to accommodating office space, acoustics, thermal, and power
considerations, the VRTX provides administrators with a unified interface, the Chassis
Management Controller, for performing routine systems management tasks.
Administrators can manage the VRTX locally or remotely from a centralized datacenter.

The VRTX chassis supports up to 120 TB of shared internal storage that is
presentable as virtual drives to single or multiple compute nodes, and provides optional
pass-through and eight PCle® slots for additional device connectivity. The chassis-
integrated storage can be configured with 25 bays for 2.5-inch drives, which we tested

in this report, or with 12 bays for 3.5-inch drives. The VRTX integrated switch, which is
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available as a 1GB or 10GB switch, contains multiple external network ports for easy
expansion or integration into any computing environment. The VRTX is virtualization-
ready and can enable a virtual desktop infrastructure for general-purpose computing in
remote and branch offices.

For more information about the Dell EMC PowerEdge VRTX, visit
http://www.dell.com/en-us/work/learn/modular-infrastructure.

About the Dell EMC PowerEdge M630 server nodes
According to Dell EMC, the PowerEdge M630 blade server “offers flexibility to

optimize in-server storage and 10 performance, allowing you to tailor your servers to
your workloads today and adapt as your needs change over time.”

The optional 12Gb PowerEdge RAID Controller (PERC) doubles the throughput
and cache of previous generations and can dramatically boost |0 for applications. The
M630 supports up to four 1.8-inch SSDs or up to two 2.5-inch HDDs or Express Flash
PCle SSDs. Dell EMC Select Network Adapters offer quick access to the storage resources
your server or cloud requires, via either NAS or SAN.

For more information about the Dell EMC PowerEdge M630 blade server, visit

www.dell.com/us/business/p/poweredge-m630/pd.

About the Intel Xeon processor E5-2600 v3 product family
According to Intel, the Intel Xeon processor E5-2600 v3 product family “helps IT

address the growing demands placed on infrastructure, from supporting business
growth to enabling new services faster, delivering new applications in the enterprise,
technical computing, communications, storage, and cloud.” It also delivers benefits in
performance, power efficiency, virtualization, and security.
The E5-2600 v3 product family has up to 50 percent more cores and cache than
processors from the previous generation. Other features include the following:
* Intel Advanced Vector Extensions 2 (AVX2)
* Intel Quick Path Interconnect link
* Upto 18 cores and 36 threads per socket
* Upto 45 MB of last-level cache
* Next-generation DDR4 memory support
* Intel Integrated I/O providing up to 80 PCle lanes per two-socket server
* Intel AES-NI data encryption/decryption
The Intel Xeon processor E5-2600 v3 product family also uses Intel Intelligent
Power technology and Per-core P states to maximize energy efficiency.
Learn more at www.intel.com/content/www/us/en/processors/xeon/xeon-e5-
brief.html.
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WHAT WE TESTED

Database testing

File and print testing

Mail testing

To create our real-world ecommerce workload, we used the DVD Store Version
2.1 benchmarking tool. DS2 models an online DVD store, where customers log in, search
for movies, and make purchases. DS2 reports these actions in orders per minute that
the system could handle, to show what kind of performance customers could expect.
The DS2 workload also performs other actions, such as adding new customers, to
exercise the wide range of database functions you would need to run your ecommerce
environment. For more details about the DS2 tool, see

www.delltechcenter.com/page/DVD+Store.

To test the file and print capabilities of the solutions, we simulated workloads
using the lometer benchmark. lometer measures IOPS on single and clustered systems.
lometer performs I/O operations to stress a system, and then records the performance
of these I/O operations and the system stress they create. We used lometer version 1.1
on each solution to simulate the same file and print workloads on the solutions. For

more details about lometer, see www.iometer.org.

To test the solutions’ mail server performance, we used the Microsoft Load
Generator 2013 (LoadGen) benchmark, performing tasks to simulate a heavy user
generating mail activity. For our workloads, we used the following settings:

*  Number of users: 750
*  Mailbox Profile: 250MB
¢ Action Profile: Outlook_200

For more details about LoadGen, see
www.microsoft.com/downloads/details.aspx?Familyld=DDEC1642-F6E3-4D66-A82F-
8D3062C6FA98&displaylang=en.
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IN CONCLUSION

Keeping a legacy disparate hardware solution instead of choosing the Dell EMC
PowerEdge VRTX powered by the Intel Xeon processor E5-2600 v3 family may cost more
than one would expect. We found that the VRTX with two Intel Xeon processor E5-2650
v3-powered Dell EMC PowerEdge M630 server nodes supported a heavier workload
than a legacy disparate hardware solution across email, database, and file/print server
simultaneous workloads while reducing power consumption by 41.5 percent.

The PowerEdge VRTX achieved these savings using 70.6 percent less rack-
equivalent space than the legacy disparate hardware solution and with one-third as
many cables, to reduce complexity and reduce the burden of space in small offices.

Finally, despite a larger initial investment, the PowerEdge VRTX with two Intel
Xeon processor E5-2600 v3-powered PowerEdge M630 server nodes could actually
lower the total cost of ownership over years as much as 30.2 percent, delivering a solid
return on investment in less than three years.

As our test results show, investing in the Dell EMC PowerEdge VRTX solution
powered by the Intel Xeon processor E5 v3 family could provide a compact solution to
optimize application performance and reduce complexity at a lower lifetime cost than a

legacy solution.
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APPENDIX A - SYSTEM CONFIGURATION INFORMATION
In September 2016, Dell EMC rebranded the Dell PowerEdge VRTX and Dell PowerEdge M630 as the Dell EMC
PowerEdge VRTX and Dell EMC PowerEdge M630. We completed our testing prior to that rebranding.

Figures 12 and 13 provide detailed configuration information for the test systems.

System

Dell PowerEdge VRTX solution

Enclosure

Compute node enclosure

Dell PowerEdge VRTX

General dimensions of compute node enclosure

Height (inches) 8
Width (inches) 19
Depth (inches) 29.5
U size in server rack equivalent (U) 5
Power supplies

Total number 4

Vendor and model number

Dell 80 Plus Platinum E1100E-SO (P/N 0YT39Y)

Wattage of each (W)

1,100

Cooling fans

Total number

6

Vendor and model number

Delta Electronics, Inc.

Dimensions (h x w) of each

60 mm x 60 mm

Volts 12

Chassis RAID controller

Vendor and model number Dell SPERC8
Firmware version 23.11.46-0079
Cache size (GB) 1

Chassis shared hard drives

Hard drive #1

Vendor and model number

Dell ST300MMO0006

Number of drives 10

Size (GB) 300

RPM 10k

Type SAS 6.0 Gbps
Hard drive #2

Vendor and model number Dell CO6VX
Number of drives 2

Size (TB) 400

RPM SSD

Type SAS 12.0 Gbps
Chassis USB ports

Number 2

Type 2.0

Platform

Vendor and model number

Dell PowerEdge M630
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System Dell PowerEdge VRTX solution
Motherboard model number 0JXJPT
Motherboard chipset Intel C600

BIOS name and version Dell BIOS 1.1.8
BIOS settings Default

General

Number of processor packages 2

Number of cores per processor 10

Number of hardware threads per core 2

System power management policy Performance/watt
CPU

Vendor Intel

Name Xeon E5-2650 v3
Stepping MO

Socket type Socket 2011-3 LGA
Core frequency (GHz) 2.30

L1 cache 32 KB (per core)
L2 cache 256 KB (per core)
L3 cache 25 MB (shared)

Memory modules (per node)

Total RAM in system (GB)

64

Vendor and model number

Hynix Semiconductor
M393A1G43DB0-CPB

Type PC4-2133P
Speed (MHz) 2,133

Speed in the system currently running @ (MHz) 2,133
Timing/latency (tCL-tRCD-iRP-tRASmin) 13-13-13-33
Size (GB) 8

Number of RAM modules 8

Chip organization Double-sided
Rank Dual

RAID controller

Vendor and model number

Dell PERC H730 Mini

Firmware version

25.2.1.0037

Cache size (GB)

1024 MB

Network adapter

Vendor and model number

Broadcom® NetXtreme® Il 10 Gb Ethernet BCM57810s

Type Integrated
Number of Network Adapters 1

USB ports (per node)

Number 2

Type 3.0

Figure 12: Detailed configuration information for the Dell PowerEdge VRTX solution.
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Server

HP Proliant ML110 G6

HP ProlLiant ML310 G5

HP ProlLiant ML370 G5

General dimensions of server

Height (inches) 14.4 17.0 17.5
Width (inches) 6.9 7.9 8.6
Depth (inches) 16.8 24.0 28.5
U size in server rack
equivalent (U) 4 > >
Power supplies
Total number 1 1 1
Delta Electronics® Delta Electronics DPS- HP Switching Power Suppl
Vendor and model number | pc500g 410DB DPS-800GB i o
Wattage of each (W) 300 410 850
Cooling fans
Total number 1 1 3

Vendor and model number

HP 576930-001

HP 459188-001

Nidec Beta V35633-94

Dimensions (h x w) of each

92 mm x 25 mm

120 mm x 25 mm

130 mm x 125 mm

Volts 12 12 12

General

Motherboard model 576924-001 A61TR1 434719-001
number

Motherboard chipset Intel 3400 Chipset Intel 3210 Chipset Intel C600

BIOS name and version

HP System BIOS -
0270126_TAN

ProLiant System BIOS - W05

ProLiant System BIOS P57

BIOS settings Performance Performance Performance
Number of processor 1 1 5

packages

Number of cores per 4 4 4

processor

Number of hardware 5 1 1

threads per core

System power management

Static High Performance

Static High Performance

Static High Performance

policy

CPU

Vendor Intel Intel Intel

Name Xeon X3460 Xeon X3370 Xeon E5450
Stepping B1 EO EO

Socket type LGA 1156 LGA 775 LGA 771
Core frequency (GHz) 2.80 3.00 3.00

L1 cache

32 KB (per core)

32 KB (per core)

32 KB (per core)

L2 cache

256 KB (per core)

12 MB (shared)

12 MB (shared)

L3 cache (MB) 8 N/A N/A
Memory modules
Total RAM in system (GB) 4 4 8

Vendor and model number

Samsung® M391B5673EH1-
CH9

Micron® MT18HTF25672AY-
800E1

Samsung M395T5160QZ74

Comparing performance and cost: Dell EMC PowerEdge VRTX with
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Server HP ProLiant ML110 G6 HP ProLiant ML310 G5 HP ProLiant ML370 G5
Type PC3-10600E DDR3 PC2-6400E DDR2 DDR2-5300F
Speed (MHz) 1,333 800 666
Speed in the system
1,333 800 666
currently running @ (MHz) ’
Timing/latency (tCL-tRCD-
iRP-tRASMIN) 9-9-9-24 6-6-6-18 5-5-5-15
Size (GB) 2 2 4
Number of RAM modules 4 2 8
Chip organization Double-Sided Double-sided Double-sided

RAID controller

Vendor and model number

HP Smart Array B110i

HP Smart Array E200

HP Smart Array P400

Cache size (MB)

N/A

128

256

Hard drive #1

Vendor and model number

Hitachi® HDS721032CLA362

HP DF0792A9844

HP EGO146FAWHU

Number of drives 1 2 2
Size (GB) 320 72 146
RPM 7.2K 15K 10K
Type SATA SAS SAS
Hard drive #2

Vendor and model number | N/A STS500NMO001 N/A
Number of drives N/A 2 N/A
Size (GB) N/A 500 N/A
RPM N/A 7.2 N/A
Type N/A SAS N/A

Network adapter

Vendor and model number

Intel Pro/1000 PT Dual Port

Intel Pro/1000 PT Server

Intel Pro/1000 PT Dual Port

Server Adapter Adapter Server Adapter
Type PCle PCle PCle
Number of ports 2 1 2
Network adapter 2
Vendor and model number | HP NC 107i PCle Gigabit Intel Pro/1000 PT Server N/A

Adapter

Type Integrated PCle N/A
Number of ports 1 1 N/A
USB ports (per node)
Number 6 2 4
Type 2.0 2.0 2.0

Figure 13: Detailed configuration information for the towers in the legacy hardware solution.
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APPENDIX B - HOW WE TESTED

Our test scenario used two clustered PowerEdge M630s and a PowerEdge R710, which we used for our

infrastructure server and to host client VMs. Figure 14 presents the virtual machines in our test environment.

Host for
VM name vCPUs Memory PowerEdge (0} OS drive Additional drive
M630 tests
8 sockets, Windows Server 100 GB stored
ExchangeCAS | eachw/1 | 16 GB M630 A 2012 R2 Standard | on VRTX HDDs None
core
750 GB, Thick
8 sockets, Windows Server 100 GB stored Provisioned Eager
ExchangeMB ig:: w/1 | 16GB M630 A 2012 R2 Standard | on VRTX HDDs Zeroed, Stored on VRTX
HDDS
lometer Zelasc?:l\(/\(/e/tsll 8 GB M630 B Windows Server 100 GB stored Eg GeE'ZE:::dPrSTcI)IrSeIZnoe:
2012 R2 Standard | on VRTX HDDs & '
core VRTX SSDs
100 GB, Thick
8 sockets, Windows Server 100 GB stored Provisioned Eager
>QL ig:: w/1 | 8GB M630B 2012 R2 Standard | on VRTX HDDs Zeroed, Stored on VRTX
SSDs
1 socket .
DVD Store w/ 4 3 GB R710 Windows Server 100 GB stored None
client 2012 R2 Standard | on R710 HDDs
cores
Exchange 1 socket Windows Server 100 GB stored
8 GB R710 N
AD/DNS w/ 1 core 2012 R2 Standard | on R710HDDs | " o"¢
1 socket Windows Server
LoadGen 100 GB stored
client w/ 4 8 GB R710 2008 R2. on R710 HDDs None
cores Enterprise
1 socket
Windows Server 100 GB stored
NAT w/ 4 8GB R710 2012 R2 Standard | on R710 HDDs | O"®
cores
VMware 2 sockets, VMware vCenter 100 GB, Thin
. 25 GB stored ..
vCenter eachw/1 | 8GB R710 Server Appliance on R710 HDDs Provisioned, Stored on
Server core 5.5 the R710 disks

Figure 14: The virtual machines in our test environment.

We also followed the following guidelines:

All OS drives were thin provisioned.
All VMs hosted on the blade servers were stored on the VRTX storage.

All VMs hosted by the infrastructure server were stored on the infrastructure’s drives.

P w R

On all servers, we installed all Windows updates available up to 05/15/2015.
In addition to its first drive, ExchangeMB had a 100 GB, Thick Provisioned Eager Zeroed drive stored on the OS

storage volume used for storing backups.

Comparing performance and cost: Dell EMC PowerEdge VRTX with
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Installing and configuring the infrastructure server
We configured a Dell PowerEdge R710 server with VMware vSphere (ESXi) 5.5.0 with Dell Drivers to host the

Active Directory® VMs and the VMware vCenter VM.

Installing VMware vSphere 5.5 with Dell Drivers (ESXi) on the Dell PowerEdge R710
1. |Insert the ESXi 5.5 disk, and select Boot from disk.
On the Welcome screen, press Enter.
On the End User License Agreement (EULA) screen, press F11.
On the Select a Disk to install or Upgrade Screen, select the relevant volume to install ESXi on, and press Enter.

On the Please Select a Keyboard Layout screen, press Enter.

AN A

On the Enter a Root Password screen, assign a root password, and confirm the password by entering it again.
Press Enter to continue.
7. On the Confirm Install Screen, press F11 to install.

8. On the Installation complete screen, press Enter to reboot.

Configuring ESXi after installation

1. Onthe ESXi 5.5 screen, press F2, enter the root password, and press Enter.
On the System Customization screen, select Troubleshooting Options, and press Enter.
On the Troubleshooting Mode Options screen, select enable ESXi Shell, and press Enter.
Select Enable SSH, press Enter, and press Esc.
On the System Customization screen, select Configure Management Network.

On the Configure Management Network screen, select IPv4 Configuration.
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On the IPv4 Configuration screen, select Set static IP; enter an IP address, subnet mask, and default gateway;

and press Enter.

8. On the Configure Management Network screen, press Esc. When the installer asks if you want to apply the
changes, press Y.

9. Lloginas root with the vSphere client.

10. Select the Configuration tab, and click Networking.

11. Click Add Networking...

12. Create a virtual machine network called PRIV-NET, and select the adapter with access to the private test
network.

13. Click OK.

14. Select the Configuration tab, and click DNS and routing.

15. Type a name, and select test.local for domain.

Setting up two VMs to host the Microsoft Windows® Active Directory server and the NAT

server
1. Inyour web browser, connect to the vSphere server, and browse to the ESXi host hosting the management VMs

(in our case, the PowerEdge R710).
2. Right-click the ESXi host, and choose New Virtual Machine.

3. Onthe Create New Virtual Machine window, select custom, and click Next.
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Assign a name to the virtual machine, and click Next.
Select the LUN for the storage, and click Next.
Select Virtual Machine Version 11, and click Next.

Choose Windows, select Microsoft Windows Server 2012, and click Next.
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Choose the VM'’s virtual hardware options, and click Next (see each VM’s section below for additional VM
configuration data).
* Select one virtual processor socket, and one core per virtual socket.
* Select 4GB RAM.
* Select the NIC interface with access to the private test network.
* Leave the default option for SCSI controller.
9. Choose to create a new virtual disk, and click Next.
10. Make the OS virtual disk size 100 GB, choose thin provisioned, specify external storage, and click Next.
11. Keep the default virtual device node (0:0), and click Next.
12. Click Finish.
13. Right-click the VM, and select Edit Settings.
14. Click the Resources tab, and click Memory.
15. Select Reserve all guest memory, and click OK.
16. Connect the VM virtual CD-ROM to the Microsoft Windows Server 2012 R2 installation disk.
17. Start the VM.

Installing Microsoft Windows Server 2012 R2 Standard Edition
1. Connect the installation media and power on the VM.
When the option appears, press F11 to enter the Boot Manager.
Select the connected boot media, and press Enter.
Press any key when prompted to boot from DVD.
When the installation screen appears, click My language is English.
Leave language, time/currency format and input method as default, and click Next.
Click Install now.
When the Windows Setup window appears, click No thanks when prompted to go online to install updates.
Select Windows Server 2012 R2 Standard (Server with a GUI), and click Next.

. Check | accept the license terms, and click Next.
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. Click Custom: Install Windows only (advanced).
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. Press Alt+A to open advanced partition options. Delete any partitions until there is only Drive 0 Unallocated
Space.
13. Select Drive 0 Unallocated Space, and click Next, at which point Windows will begin installing, and will restart
automatically after completing.
14. When the Settings page appears, fill in the Password and Reenter Password fields with the same password.

15. Log in with the previously set up password.

Comparing performance and cost: Dell EMC PowerEdge VRTX with A Principled Technologies test report 19
two Dell EMC PowerEdge M630 server nodes vs. a legacy solution



Configuring Windows Update
1. Inthe left pane of the Server Manager window, click Local Server.
2. Inthe main frame, next to Windows Update, click Not configured.
3. Inthe Windows Update window, in the main pane, click Let me choose my settings.
4. Under Important updates, select Never check for updates (not recommended), and then click OK.
5. Inthe left pane, click Check for updates, and install all available updates.

6. Close the Windows Update window.

Configuring Windows Firewall
1. In Server Manager, click Tools=> Windows Firewall with Advanced Security.
In the Overview section, click Windows Firewall Properties.
In the Domain Profile tab, for Firewall state, click Off.
In the Private Profile tab, for Firewall state, click Off.
In the Public Profile tab, for Firewall state, click Off.
Click OK.

Close the Windows Firewall Properties window.
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Setting up Remote Desktop
1. Inthe Local Server tab of the Server Manager window, next to Remote Desktop, click Disabled.
2. Inthe System Properties window that appears, in the Remote Desktop section, select the Allow remote
connections to this computer radio button, and click OK when the warning message appears.
3. Uncheck Allow connections only from computers running Remote Desktop with Network Level Authentication

(recommended), and click OK.

Disabling IE Enhanced Security Configuration
1. Inthe Local Server tab of the Server Manager window, next to IE Enhanced Security Configuration, click On.
2. Inthe Internet Explorer Enhanced Security Configuration window, select the Off radio buttons for both

Administrators and Users, and click OK.

Installing VMware Tools
1. |Install VMware Tools. For more information, see

kb.vmware.com/selfservice/microsites/search.do?language=en_US&cmd=displayKC&externalld=340.

Repeat the virtual machine, OS installation, and OS configuration described above to create a VM for the NAT server.
Installing Active Directory and DNS services
1. Power on the Active Directory VM.
On the Active Directory server, open Windows PowerShell®.
Run the following command: Install-WindowsFeature RSAT-ADDS
When the installation is finished, close PowerShell.
On the VM, open Server Manager.

On the Welcome screen, click 2, and click Add roles and features.
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At the initial Before you begin screen, click Next three times.
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10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.

At the Server Roles screen, select Active Directory Domain Services.

On the pop-up window, click Add Features.

Click Next three times.

Verify the desired role is being installed, and click Install.

Once installation has finished, close the Add roles and features wizard.

In Server Manager, click the flag at the top, and select the Promote this server to a domain controller link.
Select Add a new forest, enter a root domain name of test.local and click Next.
On the Domain Controller Options screen, enter a password, and click Next.

On the DNS Options screen, click Next.

On the Additional Options screen, click Next.

On the Paths screen, click Next.

On the Review Options screen, click Next.

On the Prerequisites screen, verify all prerequisites have passed, and click Install.

Once Active Directory Domain Services finishes installing, click Finish, and restart the system.

Installing the NAT on the NAT server

Before installing the network address translation (NAT) service, you will need to plug a second network cable

into the R710 server that has access to the internet and configure vSphere to make that connection available as a
second NIC for the NAT VM.
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On the NAT server, open the Add Roles and Feature Wizard.

On the Before you Being screen, click Next.

On the Installation Type screen, click Next.

On the Server Selection screen, click Next.

On the Server Roles screen, select Remote Access, and click Next.

On the Features screen, click Next.

On the Remote Access screen, click Next.

On the Role Services screen, select Routing, click Add Features on the popup, and click Next.
On The Web Server Role (lIS) screen, click Next.

. On the Role Services screen, click Next.

. On the Confirmation screen, click Install.

. Once the installation is complete, click Close.

. From Administrative Tools, open Routing and Remote Access...

. In the left panel, right-click the target server and select Configure and Enable Routing and Remote Access.
. In the Routing and Remote Access Server Setup Wizard, click Next.

. On the Configuration screen, select Network Address Translation (NAT).

. On the NAT Internet Connection screen, select the Ethernet port that will provide internet connection and click

Next.

. On the Completion screen, click Finish. When setting static IP address, the vCenter server’s IP can now be used

as the gateway on the isolated testing network.
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Configuring the VMware vSphere environment for the VRTX server nodes

Installing and configuring vCenter Server

16.

In the vSphere client, select File, then Deploy OVF Template.

In the Deploy OVF Template window, click Browse, then browse to the location of the vCenter Server Appliance
.ovf file, click Open, and click Next.

On the OVF Template Details screen, click Next.

In the Name and Location screen, enter vCenter Server for the name, and click Next.

In the Storage screen, select the appropriate datastore, and click Next.

In the Disk Format screen, select Thin Provision, and click Next.

In the Network Mapping screen, select the private test network.

In the Ready to Complete screen, check the Power on after deployment checkbox, and click Finish.

In the vSphere client, right-click the new vCenter, and select Open Console.

. Note the instructions and the address to use for configuration.

. Open a web browser to the address listed in the console.

. Log in with root and the password vmware

. In the vCenter Server Setup window, check the box to accept the license agreement, and click Next.
. In the Configure Options screen, select the Configure with default settings, and click Next.

. In the Review Configuration screen, click Start. Setup will complete, and a new database will be configured

automatically. When it is finished, click Close.
Click the Admin Tab.
a. Inthe current administrator password section, enter vmware

b. Enter a new password into both password fields.

Configuring the VRTX shared storage

1. Open a web browser, and enter the address listed for the CMC IP on the front LCD display.
2. Login with the appropriate credentials.
3. Expand Storage.
4. Click Storage.
5. Click the Setup tab.
a. Under Assignment Mode, select the Multiple Assignment radio button, and click Apply.
b. To confirm the Operation Successful message box, click OK.
6. Configure virtual disks:
Click Storage—> Virtual Disks.
On the Virtual Disks tab, click Create.
i. For Media Type, select HDD.
ii. For Choose a virtual disk type, select RAID 10.
iii. Select the 10 available 300 GB hard disk drives.
iv. For the first volume (to be used for Microsoft Exchange), enter 8 50GB and click Create Virtual
Disk.
v. To confirm the message box indicating Operation Successful, click OK.
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vi. Repeat steps ithrough iv for the next external volume (to be used for system operating
systems), choosing 500GB.
vii. For Media Type select SDD.
viii. For Choose a virtual disk type, select RAID 1.
ix. Select the two available 400 GB SSDs.
X. For the first volume (to be used for Microsoft SQL Server), enter 120GB and click Create Virtual
Disk.
xi. To confirm the message box indicating Operation Successful, click OK.
xii. Repeat steps ix through for the next external volume (to be used for lometer), choosing 1 00GB.
c. On the Virtual Disks tab, click Manage.
i. Select the Virtual Disks Action drop-down menu for Virtual Disk 0, and initialize the drives.
ii. Click Apply.
iii. To confirm the message box indicating Operation Successful, click OK.
iv. Repeat steps i through iii for the remaining virtual disks.
d. Allow shared LUN access to both compute nodes. On the Virtual Disks tab, click Assign.
i. Use the drop-down menu for all virtual disks and SLOT-01, and select Full Access.
ii. Use the drop-down menu for all virtual disks and SLOT-02, and select Full Access.
iii. Use the drop-down menu for all virtual disks and SLOT-03, and select Full Access.
iv. Use the drop-down menu for all virtual disks and SLOT-04, and select Full Access.
v. Click Apply.
vi. To confirm the Operation Successful message box, click OK.

Configuring the VMware vSphere environment for the VRTX server nodes
Configuring boot properties of the Dell PowerEdge M630 servers
1. Open a web browser, and enter the address listed for the CMC IP on the front LCD display.
2. Login with the appropriate credentials.
3. Expand Server Overview, and select Slot-01.
4. Click the Setup Tab. Perform the following steps in the iDRAC settings:
Check the Enable LAN checkbox.
Check the Enable IPv4 checkbox.
Check the DHCP checkbox.
Check the IPMI Over LAN checkbox.
Click Apply iDRAC Network Settings.
f. To confirm changes to the iDRAC network settings, click OK.
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5. Power on the server.

Click the Power Tab.

Select Power On Server.

Click Apply.

To confirm server control action, click OK.
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To confirm operation was successful, click OK.
6. Click the Propertles tab.

7. Click Launch Remote Console.
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8. On new browser page, click Continue to website (not recommended) if prompted.

If a message appears indicating a pop-up was blocked, select Always allow pop-ups from this site.

a
b. Close the browser tab for the iDRAC.
c. Click Launch Remote Console.

d

If a message appears indicating the Web page wants to run an add-on called “Virtual Console from

Dell Inc.,” select Allow for all websites.

9. A new window appears showing the console for the server to configure. Select Power— Reset System.

10. Change the boot disk order in System Setup.

Click System BIOS.

Click Boot Settings.

Click BIOS Boot Settings.

Scroll down, and click Hard Disk Drive Sequence.
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When prompted during POST, press F2 to enter System Setup.

i. Highlight the SD card or USB drive entry, and move it to the top using the + key.

ii. Click OK.
Click Back twice.
Click Finish.
Click Yes.
i. Click Finish.
j.  Click OK. The system will restart.

> @

Installing VMware vSphere 5.5 (ESXi) on the Dell PowerEdge M630 servers

1. Mount the ESXi 5.5 I1SO via the iDRAC, and boot the M630 to that ISO.
On the Welcome screen, press Enter.

2
3. Onthe End User License Agreement (EULA) screen, press F11.
4

On the Select a Disk to install or Upgrade Screen, select the an SD card or USB drive to install ESXi on, and press

Enter.

v

On the Please Select a Keyboard Layout screen, press Enter.

On the Enter a Root Password Screen, assign a root password, and confirm the password by entering it again.

Press Enter to continue.
7. On the Confirm Install Screen, press F11 to install.
8. On the Installation complete screen, press Enter to reboot.

9. Repeat for the additional PowerEdge M630.

Configuring VMware vSphere (ESXi) embedded on server nodes
1. Complete configuration of ESXi host:
Press F2.
Enter the root account password, and press Enter.
Select Configure Management Network, and press Enter.
Select Network Adapters.
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Press Esc.
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g. To restart networking, press Y.
h. Select Troubleshooting Options.
i. Select Enable ESXi shell, and press Enter.
ii. Select Enable SSH, and press Enter.
iii. Press Esc.
i. Tologout, press Esc.
2. Repeat for the second PowerEdge M630.
Adding the server nodes to the vCenter Server
1. Inaweb browser, navigate to the vCenter IP, click Log in to vSphere Web Client, and log in using root and your
password.
In the left panel, select vCenter, then Datacenters.
Right-click in the empty panel, and select New Datacenter.
In the New Datacenter window, give the Datacenter a name and click OK. We used VRTX-01
Select your test datacenter.
On the left panel, select Hosts, then click Add a host.
On the Name and Location screen, enter the IP address for the R710 client and click Next.

On the Connection settings screen, enter the User name and Password and click Next.
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On the Host summary screen, click Next.
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. On the Assign license screen, click Next.
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. On the Lockdown mode screen, click Next.
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. On the VM location screen, click Next.
13. Repeat steps 7-11 for both PowerEdge M630s.

Configuring the external volumes
1. Inthe vSphere client, select the first host.
Click the Configuration tab.
Click Storage, and click Add Storage...
Choose Disk/LUN.
Select the disk, and click Next.
Accept the default of VMFS-5 for the file system.
Review the disk layout, and click Next.

Enter the datastore name, and click Next.
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Accept the default of using maximum capacity, and click Next.
10. Click Finish.

11. Repeat for all volumes available through the Shared PERC 8 Mini.
12. Add shared storage on the second host:

a. On the second host, click the Configuration tab.

b. Click the Storage menu.
c. The new storage should appear automatically. If no storage is listed, click Rescan All...
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d. Click OK to rescan all adapters. The shared storage will appear automatically with the name VRTX-
shared-01 already configured.

Setting up a high-availability cluster

1.
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10.
11.

Right-click the VRTX-01 Datacenter.

Select New Cluster.

Name the cluster. For our testing, we used VRTX-M630
Check the Turn On vSphere HA checkbox, and click Next.
Accept all vSphere HA defaults, and click Next.

Accept Virtual Machine Options defaults, and click Next.
Accept VM Monitoring defaults, and click Next.

Accept VMware EVC defaults, and click Next.

Accept VM Swapfile Location defaults, and click Next.
To create the cluster, click Finish.

Click and drag each ESXi host into the cluster to populate it.

Creating the first VM

1. Using the vSphere client, connect to the vCenter Server.

2. Right-click the cluster, and choose New Virtual Machine.

3. On the Configuration screen, choose Custom, and click Next.

4. Onthe Name and Location screen, add a name, select the datacenter, and click Next.

5. On the specific Host screen, choose the first PowerEdge M630 blade and click Next.

6. On the Storage screen, select the OS datastore on the external storage, and click Next.

7. On the Virtual Machine Version screen, choose Virtual Machine Version 8, and click Next.

8. On the Guest Operating System screen, choose Windows, select Microsoft Windows Server 2012 R2 (64-bit), and
click Next.

9. On the CPUs screen, choose 1 virtual socket, and 4 virtual processors per core, and click Next.

10. On the Memory screen, choose 8 GB RAM, and click Next.

11. On the Network screen, click 1 for the number of NICs, select the NIC connected to the isolated testing network,
and click Next.

12. On the SCSI Controller screen, leave the default virtual storage controller, and click Next.

13. On the Select a Disk screen, choose to create a new virtual disk, and click Next.

14. On the Create a Disk screen, make the OS virtual disk size 100 GB, and choose thin provisioned.

15. On the Advanced Options screen, leave the default virtual device node (0:0), and click Next.

16. On the Ready to Complete screen, click Finish.

17. Right-click the VM, select Upgrade Virtual Hardware, and click Yes.

18. Start the VM.

19. Attach the Windows Server 2012 R2 ISO image to the VM, and install Windows Server 2012 R2 on your VM.
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Installing the operating system on the VMs
Repeat the sections above regarding the initial creation of the virtual machines and installation of Windows

Server 2012 R2 Standard.

Cloning the VM
1. Using the vSphere Client, right-click the first VM and select Template, then Clone to Template.
2. Onthe Name and Location screen, enter a Template Name.
3. Onthe Host / Cluster screen, select the management server.
4. On the Datastore screen, select a datastore, and click Next.
5. On the Ready to Complete screen, click Finish.
The template created will be used to clone out the rest of the VMs.

Installing and configuring Microsoft Exchange Servers
We installed Microsoft Exchange 2013 SP3 CAS server and mailbox server on two VMs residing on the first Dell

PowerEdge M630.

Configuring the Exchange 2013 VMs on the VRTX
After cloning, modify the Exchange 2013 VM s to contain the following settings:
* Memory: 16 GB
* Virtual Processors: 8
* Additional virtual disks for the mailbox server.
o 1 x750GB virtual disk for mailbox storage (Thick-provisioned, eager-zeroed)
o 1 x100GB virtual disk for log storage (Thick-provisioned, eager-zeroed)

After adding the drives from the vSphere client, configure additional drives in Windows using the following steps.
1. Inthe taskbar, click the Server Manager icon.

In the left pane, expand Storage, and click Disk Management.

Right-click the first volume, and choose Initialize Disk.

In the right pane, right-click the volume, and choose New Simple Volume...

At the welcome window, click Next.

At the Specify Volume Size window, leave the default selection, and click Next.

At the Assign Drive Letter or Path window, choose a drive letter, and click Next.
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At the Format Partition window, choose NTFS, and click Next.

9. At the Completing the New Simple Volume Wizard window, click Finish.
Testing overview

We used the RAID 10 consisting of 300GB hard drives on the VRTX shared storage to store the Exchange

mailbox. We added two virtual drives to the Exchange Mailbox: one for Exchange data and one for logs.
For our workloads, we used the following settings:
* Users: 750
*  Mailbox Profile: 250MB mailboxes
¢ Action Profile: Outlook_200
¢ C(Client Type: Outlook 2007 Cached
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Configuring the Active Directory server
Installing the Active Directory Domain Services role
Before completing this step, you will need to apply a static IP address for the server. In our case, we used
192.168.1.10.
Launch Server Manager, and select Add roles and features.
Click Next at the Add Roles and Features Wizard.
Select Role-based or feature-based installation, and click Next.

Select the AD server from the server pool, and click Next.
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Select Active Directory Domain Services from the list of Roles, click the Add Features button to add features that
are required by Active Directory Domain Services, and click Next.

Accept the defaults selected by setup at the Select Features screen, and click Next.

Click Next at the AD DS screen.

Select Restart the destination server automatically if required at the confirmation screen, and click Install.
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Click the yellow warning triangle in the server manager window.
10. Click Promote this server to a domain controller.

11. Select Add a new forest, type in the Root domain name (fgdn), and click Next. For our testing, we used
test.local

12. Type in and confirm the password, and click Next.

13. Click Next at the DNS Options screen.

14. Verify the NetBIOS name, and click Next.

15. Accept the default paths, and click Next.

16. Review the options, and click Next.

17. Verify the prerequisite check passes successfully, and click Install.
Preparing AD for Exchange

1. Create a reverse lookup zone:

a. Click the start button, and type DNS in the search field.

b. Open the DNS manager by clicking on it in the results field.

c. Expand your Active Directory domain, and click on Reverse Lookup Zones.
d. Click Action>New Zone.

e. Click Next on the Welcome screen.

f. Chose Primary Zone, and click Next.

g. Leave default replication scope, and click Next.

h. Choose IPv4, and click Next.

i. Enterthe IP address of your domain (192 .168. 3 for our example).

j. Choose Allow both nonsecure and secure dynamic updates, and click Next.
k. Click Finish.

2. Insert the Exchange 2012 SP1 Installation ISO in the AD VM DVD drive.
3. In Windows Explorer, double-click the Exchange DVD icon.
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4. Inthe Exchange installation folder, hold down shift, and right-click.
Choose Open a command window here.

6. Run the following command: Setup.exe /PrepareSchema
/IAcceptExchangeServerLicenseTerms

7. When the previous command completes, run the following command: Setup.exe /PrepareAD
/OrganizationName:”organization name” /IAcceptExchangeServerLicenseTerms

8. Close the command window when the setup finishes.

Installing Active Directory Certificate Services

1. Launch Server Manager, and select Add roles and features.

2. Click Next at the Add Roles and Features Wizard.

3. Select Role-based or feature-based installation, and click Next.

4. Choose Active Directory Certificate Services.

5. Click Add Features, if prompted, to install any required features.

6. Click Next.

7. Click Next.

8. Click Next.

9. Choose Certificate Authority and Certification Authority Web Enroliment.
10. Click Add Features, if prompted, to install any required features.

11. Click Next.

12. Leave defaults, and click Next.

13. Click Install.

14. Click Close when the install finishes.

15. Click on the yellow warning symbol in the Server Manager, and click Configure Active Directory Certificate

Services
16. Leave defaults, and click Next.
17. Check both Certification Authority and Certification Authority Web Enrollment, and click Next.
18. Choose Enterprise CA, and click Next.
19. Choose Root CA, and click Next.
20. Choose Create a new private key, and click Next.
21. Leave defaults, and click Next.
22. Leave defaults, and click Next.
23. Leave 5 years, and click Next.
24. Leave default locations, and click Next.
25. Click Configure.
26. Close when the configuration finishes.
27. Open Internet Explorer and navigate to localhost/certsrv/Default.asp to verify that the installation

succeeded.
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Installing Exchange Server 2013 SP1 Mailbox and Client Access Server roles
Using the template, clone two VMs: one for the Exchange Client Access Server, or CAS, and the other for the
Exchange Mailbox Server. Edit the hardware settings in each. The Mailbox server should have eight vCPUs (eight virtual
sockets each with one core) and 16 GB of memory. Using the Exchange datastore, add a 750 GB disk and a 100 GB disk
to the Mailbox server for the Exchange mailbox and Exchange logs respectively. Set static IPs on both VMs and join the
domain.
1. Onthe Exchange Mailbox Server, log into the server using domain administrator credentials.

2. Open Windows PowerShell and run the following command:

Install-WindowsFeature AS-HTTP-Activation, Desktop-Experience, NET-
Framework-45-Features, RPC-over-HTTP-proxy, RSAT-Clustering, RSAT-
Clustering-CmdInterface, RSAT-Clustering-Mgmt, RSAT-Clustering-
PowerShell, Web-Mgmt-Console, WAS-Process-Model, Web-Asp-Net4d5, Web-
Basic-Auth, Web-Client-Auth, Web-Digest-Auth, Web-Dir-Browsing, Web-Dyn-
Compression, Web-Http-Errors, Web-Http-Logging, Web-Http-Redirect, Web-
Http-Tracing, Web-ISAPI-Ext, Web-ISAPI-Filter, Web-Lgcy-Mgmt-Console,
Web-Metabase, Web-Mgmt-Console, Web-Mgmt-Service, Web-Net-Ext45, Web-
Request-Monitor, Web-Server, Web-Stat-Compression, Web-Static-Content,
Web-Windows-Auth, Web-WMI, Windows-Identity-Foundation

3. Restart the server.

b

Download the Microsoft Unified Communications Managed API 4.0, Core Runtime 64-bit
(go.microsoft.com/fwlink/p/?linkld=258269).

Run UcmaRuntimeSetup.exe.

When the installation completes, click Finish.

Navigate to the location of the Exchange installation media, and double-click Setup.exe.
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At the Check for Updates? screen, check the Connect to the Internet and check for updates checkbox, and click
Next.
9. When the updates complete, click Next.
10. At the Introduction screen, click Next.
11. At the License Agreement screen, check the box to accept the terms, and click Next.
12. At the Recommended Settings screen, check the Don’t use recommended settings checkbox, and click Next.
13. At the Server Role Selection, select Mailbox or Client Access role, and click Next.
14. At the Installation Space and Location screen, leave the default location for the installation, and click Next.
15. At the Malware Protection Settings, select Yes to disable, and click Next.
16. At the Readiness Checks screen, allow the verification to complete. If there are no failures, click Install.
17. When the installation completes, click Finish, and restart the server.
18. Repeat steps 1 —17 for the Exchange CAS server.
Configuring Exchange
1. Onthe CAS server, open the Exchange Admin Center by using a browser and navigating to
https://localhost/ecp
2. Enter the domain administrator credentials, and click Sign in.

3. |If prompted, select the language and time zone, and click Save.
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16.
17.
18.
19.
20.
21.

In the left pane, click Mail Flow, then click Send Connectors.

On the Send Connectors page, click the New icon.

In the New Send Connector wizard, specify SMTP as the name and select Internet as the type. Click Next.
In the Network settings screen, choose MX record associated with recipient domain, and click Next.

In the Address space screen, click the Add icon.

In the Add domain window, enter * in the Fully Qualified Domain Name (FQDN) field, and click Save.

. Click Next.

. In the Source Server screen, click the Add icon.

. In the Select a Server window, select the mailbox server, click Add, and then click OK.

. Click Finish.

. In the left pane of the EAC, click servers, select the name of the CAS server, and click Edit.

. Click Outlook Anywhere, and enter the appropriate FQDN of the Client Access Server for the external and

internal hostname field. For example, exchangeserver.test.local
Choose NTLM as the authentication method, and click Save.
Click Virtual Directories, and then click the Configure external access domain icon.
In the Select the Client Access servers to use with the external URL window, click the Add icon.
Select the CAS server, and click Add. Click OK.
Type the FQDN of the CAS server in the Enter the domain, and click Save.
Log into the Active Directory server using administrator credentials, and complete the following steps:
a. Open Server Manager, then click Tools=> DNS.
b. In DNS Manager, expand the Active Directory server name—>Forward Lookup Zones—>test.local in
the left pane.

C. Inthe right pane, verify or create the DNS records as presented in Figure 15.

Type Ho-st or.child FQDN FQDN of mail
domain/alias name server

Mail Exchanger (MX) Leave blank domain.com casserver.domain.com

Alias (CNAME) Autodiscover Autodiscover.domain.com | casserver.domain.com

Alias (CNAME) Owa Owa.domain.com casserver.domain.com

Figure 15: DNS records.

22. Log back into your CAS server.

23. In the Exchange Power Shell, run the following commands, replacing “SHostName” with the host name (not

FQDN) of your CAS server.

Set-EcpVirtualDirectory "$HostName\ECP (Default Web Site)" -InternalUlrl
((Get-EcpVirtualDirectory "S$HostName\ECP (Default Web
Site)") .ExternalUrl)

Set-WebServicesVirtualDirectory "SHostName\EWS (Default Web Site)" -
InternalUrl ((get-WebServicesVirtualDirectory "SHostName\EWS (Default Web
Site)") .ExternalUrl)
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Set-ActiveSyncVirtualDirectory "SHostName\Microsoft-Server-ActiveSync
(Default Web Site)" -InternalUrl ((Get-ActiveSyncVirtualDirectory

"SHostName\Microsoft-Server-ActiveSync (Default Web Site)") .ExternalUrl)
Set-OabVirtualDirectory "$HostName\OAB (Default Web Site)" -InternalUlrl
((Get-OabVirtualDirectory "$HostName\OAB (Default Web

Site)") .ExternalUrl)

Set-OwaVirtualDirectory "$HostName\OWA (Default Web Site)" -InternalUlrl
((Get-OwaVirtualDirectory "$HostName\OWA (Default Web

Site)") .ExternalUrl)

Set-PowerShellVirtualDirectory "SHostName\PowerShell (Default Web Site)"
-InternalUrl ((Get-PowerShellVirtualDirectory "S$SHostName\PowerShell
(Default Web Site)") .ExternalUrl)

Get-OfflineAddressBook | Set-OfflineAddressBook -
GlobalWebDistributionEnabled $True -VirtualDirectories S$SNull

24. Create a folder at the root of C: on the CAS server, and share it to Everyone with read/write permissions.

25. Log back into the Exchange admin center, and navigate to Servers—> certificates.

26. Choose the CAS server in the drop-down menu, and click the plus sign to create a new certificate.

27. Choose Create a request for a certificate from a certification authority, and click Next.

28. Name the certificate, and click Next.

29. Do not request a wildcard certificate, and click Next.

30. Click Browse, choose the CAS server, and click OK. Click Next.

31. Leave defaults, and click Next.

32. Leave defaults, and click Next.

33. Enter your organization information, and click Next.

34. Enter the path to the share you created on the CAS server, and click Finish. Example:
\\cas\share\myrequest.REQ

35. Log into the AD server, and open Internet Explorer.

36. Browse to localhost/CertSrv

37. Click Request a certificate.

38. Choose advanced certificate request.

39. Choose Submit a certificate request by using a base-64-endcoded CMC...

40. Open Windows Explorer and navigate to the share folder on the CAS server where the certificate request is
stored.

41. Open the certificate with notepad and copy the content between BEGIN NEW CERTIFICATE REQUEST and END
NEW CERTIFICATE REQUEST.

42. Paste the copied content into the Saved Request window.

43. Choose Web Server in the Certificate Template drop-down menu, and click Submit.

44. Choose Base 64 encoded, and download the certificate.
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45.
46.
47.

48.
49.

50.
51.
52.
53.
54.

55.
56.
57.
58.
59.
60.
61.

62.
63.

Copy the new certificate into the share folder on the CAS server.

Log back into the CAS server and open the Exchange Admin Center.

Go to Servers—=>Certificates, and highlight the certificate you began before (should say Pending request in the
status column).

Click Complete on the right side.

Type the path to the certificate, including the certificate name, and click OK. Example:
\\cas\share\certnew.CER

Verify that the status has changed to Valid.

Edit the new entry, and click Edit.

Go to services and check SMTP and IIS, click Save.

Click Yes on the warning message.

Run the following steps on the CAS and AD servers.

Click Start, and type MMC

Click File=>Add/Remove Snap-in

Choose Certificates, and click Add.

Choose Computer account, and click Next.

Choose Local computer, and click Finish.

Click OK.

Expand Certificates=> Trusted Root Certificate Authorities=> Certificates
Click Action—> All Tasks—> Import

Click Next.

Browse to the share folder on the CAS server, and choose the new certificate you created. Click
Next.

k. Leave defaults, and click Next.

I.  Click Finish.

m. Click OK on the Import was successful message.
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Log into the CAS server and open the Exchange admin center.

Navigate to Servers—> Databases.

Restart the Microsoft Exchange Information Store service on the MB server.

Using the Edit button, disable the maintenance schedule and enable circular logging for each mailbox database.
Dismount and remount the databases.

Open the Exchange Management shell, and enter the following to move the paths of the default mailbox:
Move-Databasepath “DatabaseName” —EdbFilepath “E:\Newlocation\DBname.edb” —LogFolderpath
“F:\Newlocation”

When prompted, type A and press Enter.

Open Exchange Management Shell, and enter the following:

Get-OutlookAnywhere |Set-OutlookAnywhere -ExternalHostname cas.domain.com -
DefaultAuthenticationMethod NTLM -ExternalClientsRequireSsl $true
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Installing and configuring the Exchange 2013 mail test clients and completing LoadGen

configuration on the Exchange 2013
For our testing, we used one virtual client machine to run LoadGen 2013. To create the mail clients, we installed

several software components. We followed this process for each installation:
Installing Windows Server 2008 R2 SP1 Enterprise Edition
1. Insert the installation DVD for Windows Server 2008 R2 SP1 Enterprise into the DVD drive.

2. At the Language Selection Screen, click Next.

3. Click Install Now.

4. Select Windows Server 2008 R2 Enterprise (Full Installation), and click Next.

5. Click the I accept the license terms checkbox, and click Next.

6. Click Custom.

7. Click Next.

8. At the User’s password must be changed before logging on warning screen, click OK.

9. Enter the desired password for the administrator in both fields, and click the arrow to continue.
10. At the Your password has been changed screen, click OK.

11. Click Start, type change power-saving settings and press Enter.

12. Click Change plan settings.

13. Change the Turn off the display drop-down menu to Never.

14. Click Save changes, and close the Power Options, Screen Saver Settings, and Personalization screens.

To set up this server, we had to install several additional software components. The following subsections detail

the necessary installation processes.

Joining the domain

1. Set a static IP.

2. Select Start>Control Panel> Network Connections—=>Local Area Connection.

3. Click Properties.

4. Highlight Internet Protocol (TCP/IP), and click Properties.

5. Select the Use the following DNS server addresses radio button, and enter the IP of the DNS server in the
Preferred DNS server field. Click OK.
Right-click My Computer, and select Properties.

o

Under the Computer Name tab, click Change.
In the Computer Name Changes screen, under the Member of section, select the Domain radial box, and type
test.local

9. Select OK to start joining the domain.

10. When the screen appears asking for a person qualified on the domain, type Administrator as the username
and Passwordl as the password.

11. At the Welcome pop-up window and the window warning that you must reset the computer for the changes to
take effect, click OK.

12. At the System Properties screen, click OK.
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13. When a pop-up appears asking if you want to restart now, click Yes to restart your computer.

Installing Internet Information Services
1. Click Start=>Administrative Tools—>Server Manager.

2. On the left pane, click Roles.

3. Click Add Roles.

4. Click the Application Server checkbox.

5. When the Add features required for Application Server? screen appears, click Add Required Features.

6. Click Next.

7. Click Next.

8. At the Select Role Services page for Application Server, click the Web Server (IIS) Support checkbox.

9. Click Add Required Support Role Services.

10. Click Next.

11. Click Next.

12. At the Select Role Services page for Web Server (IIS), click IS 6 Management Compatibility, ASP, and CGl
checkboxes; and click Next.

13. Click Install.

14. Click Close.

Installing Load Generator
Download and install Load Generator 2013 using all defaults.

Importing the certificate and editing the hosts file
1. Click Start, and type MMC

2. Click File>Add/Remove Snap-in

3. Choose Certificates, and click Add.

4. Choose Computer account, and click Next.

5. Choose Local computer, and click Finish.

6. Click OK.

7. Expand Certificates> Trusted Root Certificate Authorities—=> Certificates.

8. Click Action=>All Tasks=>Import.

9. Click Next.

10. Browse to the share folder on the CAS server, and choose the new certificate you created. Click Next.
11. Leave defaults, and click Next.

12. Click Finish.

13. Click OK on the Import was successful message.

14. Open the Notepad program, and use File=> Open to open the hosts file stored at

C:\Windows\System32\drivers\etc
15. Add the IP and FQDN of the CAS server.

16. Save and close Notepad.
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Preparing Load Generator
1. Loginto the mail client.
Select Start—> All Programs—> Microsoft Exchange—> Exchange Load Generator 2013.
When the Load Generator screen appears, select Start a new test.
Select Create a new test configuration, and click Continue.

Change the total length of simulation to 1 hour.
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In the Specify test settings screen, type Passwordl as the Directory Access Password and Mailbox Account

Master Password, and click Continue with recipient management.

Create 750 users in the Mailbox Database, and click Continue.

To accept defaults for Advanced recipient settings, click Continue.

In the Specify test user groups screen, select the plus sign to add a user group.

10. Change the Client Type to Outlook 2007 Cached, the action profile to Outlook 200, and the Mailbox size to 250
MB, and click Continue.

11. In Remote configurations, check the checkbox to enable distributing the workload, enter the computer names of
all of the test clients, and click Continue.

12. Click Save the configuration file as, and name it testcfg.xml

13. Click Start the initialization phase (recommended before running the test).

14. Once you have initialized the database, create a backup copy of the Exchange mailbox databases.

Installing and configuring Microsoft SQL Server 2014
We installed Microsoft SQL Server 2014 on a VM residing on the second Dell PowerEdge M630.

Configuring the SQL Server VM (VRTX only)
1. After cloning, modify the SQL VM to contain the following settings:
o Memory: 16 GB
o Virtual Processors: 8
o Additional virtual disks:

= 1 x 100GB virtual disks for SQL database and log data (Thick provisioned, eager-zeroed)

Installing SQL Server 2014
1. Open the console for the VM or connect to the VM with RDP.
2. Mount the installation ISO to the VM.
3. Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2014 DVD, and

double-click.
4. |If the installer prompts you with a .NET installation prompt, click Yes to enable the .NET Framework Core role.
5. Inthe left pane, click Installation.
6. On the Product Key screen, enter a product key for standard, and click Next.
7. At the Setup Support Rules screen, wait for the rule check to complete. If there are no failures or relevant
warnings, click OK.
Select the Specify a free edition and from the drop-down menu, select Evaluation. Click Next.
Click the checkbox to accept the license terms, and click Next.
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10. If no failures are displayed after the setup support files are installed, click Next.

11. At the Setup Role screen, choose SQL Server Feature Installation.

12. At the Feature Selection screen, select Database Engine Services, Full-Text and Semantic Extractions for Search,
Client Tools Connectivity, Client Tools Backwards Compatibility, Management Tools — Basic, and Management
Tools — Complete. Click Next.

13. At the Installation Rules screen, click Next after the check completes.

14. At the Instance configuration screen, leave the default selection of default instance, and click Next.

15. At the Disk Space Requirements screen, click Next.

16. At the Server Configuration screen, check that NT AUTHORITY\SYSTEM is selected for SQL Server Agent and SQL
Server Database Engine. Click Next.

17. Assuming there are no failures, click Next.

18. At the Database Engine Configuration screen, select Mixed Mode.

19. Enter and confirm a password for the system administrator account.

20. Click Add Current user. This may take several seconds.

21. Click Next.

22. At the Error and usage reporting screen, click Next.

23. At the Installation Configuration Rules screen, check that there are no failures or relevant warnings, and click
Next.

24. At the Ready to Install screen, click Install.

25. After installation completes, click Close.

26. Create a SQL Server login for the ds2user (see the Configuring the database (Data generation overview) section

for the specific script to use).

27. Copy the pre-created DVD Store backup to the specified backup volume.

28. Download and install any available updates for Microsoft SQL Server 2014. We installed SQL Server 2014 SP1
and CU5.

Configuring the database workload client

For our testing, we used a single client machine for the Microsoft SQL Server client. To create this client, we
created a Windows Server 2013 R2 VM, assigned a static IP address, and installed .NET 3.5. We used this client to drive
the DVD Store benchmark we ran against the SQL database.

Configuring the database
Data generation overview
We generated the data using the Install.pl script included with DVD Store version 2.1 (DS2), providing the
parameters for our 10GB database size and the database platform on which we ran: Microsoft SQL Server. We ran the
Install.pl script on a utility system running Linux. The database schema was also generated by the Install.pl script.
After processing the data generation, we transferred the data files and schema creation files to a Windows-
based system running SQL Server 2014. We built the 10GB database in SQL Server 2014, and then performed a full
backup, storing the backup file on the C: drive for quick access. We used that backup file to restore the server between

test runs.
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The only modification we made to the schema creation scripts were the specified file sizes for our database. We

explicitly set the file sizes higher than necessary to ensure that no file-growth activity would affect the outputs of the

test. Besides this file size modification, the database schema was created and loaded according to the DVD Store

documentation. Specifically, we followed the steps below:

1. We generated the data and created the database and file structure using database creation scripts in the DS2
download. We made size modifications specific to our 10GB database and the appropriate changes to drive
letters.

2. We transferred the files from our Linux data generation system to a Windows system running SQL Server.

3. We created database tables, stored procedures, and objects using the provided DVD Store scripts.

4. We set the database recovery model to bulk-logged to prevent excess logging.

5. We loaded the data we generated into the database. For data loading, we used the import wizard in SQL Server
Management Studio. Where necessary, we retained options from the original scripts, such as Enable Identity
Insert.

We created indices, full-text catalogs, primary keys, and foreign keys using the database-creation scripts.
We updated statistics on each table according to database-creation scripts, which sample 18 percent of the
table data.

8. On the SQL Server instance, we created a ds2user SQL Server login using the following Transact SQL (TSQL)
script:

USE [master]

GO

CREATE LOGIN [ds2user] WITH PASSWORD=N'"',
DEFAULT DATABASE=[master],
DEFAULT LANGUAGE=[us english],
CHECK EXPIRATION=OFF,
CHECK POLICY=OFF

GO

9. We set the database recovery model back to full.

10. We created the necessary full text index using SQL Server Management Studio.

11. We created a database user and mapped this user to the SQL Server login.

12. We then performed a full backup of the database. This backup allowed us to restore the databases to a pristine
state relatively quickly between tests.

Figure 16 shows our initial file size modifications.

Logical name Filegroup Initial size (MB)

Database files

primary PRIMARY 3.25
custl DS_CUST_FG 5,767
cust2 DS_CUST_FG 5,767
indl DS_IND_FG 2,621
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Logical name Filegroup Initial size (MB)
ind2 DS_IND_FG 2,621
ds_misc DS_MISC_FG 2,621
ordersl DS_ORDERS 2,621
orders2 DS_ORDERS 2,621
Log files

ds_log Not Applicable 20,480

Figure 16: Our initial file size modifications.

Installing and configuring lometer
We installed lometer using all defaults on a VM residing on the second Dell PowerEdge M630.

Configuring the lometer VM (VRTX only)

After cloning, modify the lometer VM to contain the following settings:

e}

Memory: 8 GB

o Virtual Processors: 4

o Additional virtual disks:

= 1 x50GB virtual disk for lometer target (Thick provisioned, eager-zeroed)

Installing and configuring lometer on the VM

1. Download the lometer 1.1 package for Windows from www.iometer.org/doc/downloads.html.
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Double-click the installer, and click Run.
At the Welcome window, click Next.

At the License Agreement window, click | Agree.

When the installation completes, click Finish.

8. Copy the relevant access specification file to the VM.

Configuring the lometer workloads (both legacy and VRTX)

At the Choose Components window, leave the defaults selected, and click Next.

At the Choose Install Location window, change the Destination Folder to C:\lometer 1.1, and click Install.

We set up lometer to deliver a light file/print server-like I/0 load through the duration of the tests. Below we

review the specific configuration of our lometer workload.

lometer workload specifications

* 50GB dataset, 1 Outstanding I/O per target (sectors)

¢ 512KB transfer request size

* 100ms transfer delay
e 1Burstl/O
* 80% read, 100% random

®* 45 minute run time

* 60 second ramp up time

* Cycling — normal
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Running the test
Test start and run times

We ran all workloads concurrently in order to start and record all performance counters for this report. The
specific testing parameters we used for each benchmark are included in the setup sections, and specifics for launching

these tests are described below.

About running the LoadGen test

To run the test, we installed the LoadGen client and server components and simulated 750 Exchange users
targeting the Exchange VM using LoadGen’s Exchange_200 Workload profile. We ran the LoadGen benchmark for 45
minutes, and beginning at the 15-minute mark, we used a 30-minute measurement window for performance
monitoring.

For more details about LoadGen, see www.microsoft.com/download/en/details.aspx?displaylang=en&id=14060.

About running the DVD Store tests
We created a series of batch files, SQL scripts, and shell scripts to automate the complete test cycle. DVD Store
outputs an orders-per-minute metric, which is a running average calculated through the test. In this report, we report
the last OPM reported by each client/target pair.
Each complete test cycle consisted of the general steps listed below.
Clean up prior outputs from the target system and the client driver system.
Drop the database from the target.
Restore the database on the target.
Shut down the target.
Reboot the host and client system.
Wait for a ping response from the server under test (the hypervisor system), the client system, and the target.

Let the test server idle for 20 minutes.
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Start the DVD Store driver on the client.

We used the following DVD Store parameters for testing:
ds2sglserverdriver.exe --target=<target IP> —--ramp rate=10 --run time=30 --
n threads=12 --db size=10GB --think time=0.1 --detailed view=Y --
warmup_ time=15
About running the lometer tests
1. Loginto the lometer machine.
Open the lometer specification for the machine.

2
3. Click the start button.
4

After all access specifications finish running, remove the result files from the machine.
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APPENDIX C — DETAILED TEST RESULTS

Figure 17 shows the results of our database, mail, and file and print testing as well as power data for the Dell

PowerEdge VRTX with two Dell PowerEdge M630 server nodes. The median run was determined by OPM.

Dell PowerEdge VRTX with two Dell PowerEdge M630 server nodes Run 1 Run 2 Run 3 Median run
Power

Idle power (W) 373.6 375.0 375.1 375.0
Active power (W) 397.2 396.8 396.6 396.8
Database

Orders per minute | e011 | 6015 | 6029 | 6015
Mail

Average latency (ms) | 1.9 | 1.8 | 1.9 | 1.8

File and print

IOPS | 365 | 366 | 366 | 366

Figure 17: Detailed run results for the Dell PowerEdge VRTX with two Dell PowerEdge M630 server nodes.

Figure 18 shows the results of our database, mail, and file and print testing as well as power data for the legacy

disparate hardware solution we tested. The median run was determined by OPM.

Legacy, disparate hardware Run 1 Run 2 Run 3 Median run
Power

Idle power (W) 660.2 671.4 662.9 671.4
Active power (W) 679.7 678.7 678.1 678.7
Database

Orders per minute | 2,050 | 2,053 | 2,053 | 2,053
Mail

Average latency (ms) | 1.22 | 1.4 | 1.5 | 1.4

File and print

IOPS | 7.8 | 7.7 | 7.8 | 7.7

Figure 18: Detailed run results for the legacy disparate hardware solution from our testing.
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APPENDIX D — TCO CALCULATIONS

In this appendix, we estimate and compare five-year costs for the two solutions we tested in this report. Each

solution supports one SQL Server 2014 Standard Edition instance, one Microsoft Exchange 2013 Standard Edition

instance, and one instance for file/print — in three VMs on the Dell PowerEdge VRTX solution and on individual servers in

the legacy solution.

Dell PowerEdge VRTX — we include acquisition costs and annual costs to run the Dell PowerEdge VRTX solution
we tested in this report.
Legacy solution — we compared performance of the Dell PowerEdge VRTX to a set of three 4- to 5-year-old HP

servers, a shared HP storage array, and a switch. We estimate costs for this solution.

Assumptions

General

We use current U.S. dollars for all calculations.

We assume all tasks are executed by a system administrator earning in salary and benefits the equivalent of
$56.09 an hour.?

For the Dell PowerEdge VRTX solution, we assume an existing VMware vCenter server that is not included in this
cost analysis.

We consider only the costs that are platform specific. We thus omit staff costs for tasks that would be common
to the two solutions and would require same or similar effort and cost for the two solutions. These include the
cost of setting up and maintaining the SQL Server and Exchange databases, updating the operating system
versions, and updating the SQL server versions as updates become available over the five-year TCO timeframe.
We include only server licensing in this model and omit client access license costs and other client licensing.

For the legacy solution, we assume the business would repurpose legacy equipment from other uses, so would
need to purchase software for both the legacy and VRTX solutions.

We include software license costs with acquisition costs and software support costs with annual costs.

We do not include data center costs such as space or build costs because we assume the company would install

these solutions in the main office or a branch office, not in a centralized enterprise data center.

Acquisition costs

Acquisition costs for both solutions include software licenses for Microsoft Windows Server, Microsoft SQL
Server, and Microsoft Exchange Server. Costs for the Dell PowerEdge M630 servers also include VMware
vSphere license costs.

Acquisition costs for the Dell PowerEdge VRTX solution include hardware and five-year hardware support,
software licenses, and setup costs.

Acquisition costs for the Dell PowerEdge M630 servers include the 29 percent discount available for this server

model in the Dell online store.

? http://swz.salary.com/salarywizard/Systems-Administrator-1I-Salary-

Details.aspx?hdcbxbonuse=off&isshowpiechart=true&isshowjobchart=false&isshowsalarydetailcharts=false&isshownextsteps=false

&isshowcompanyfct=false&isshowaboutyou=false
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Yearly costs

* Costs for both solutions include Microsoft Software Assurance costs, energy costs for power and cooling, and

hardware management costs.

* We include costs to power and cool the solutions using power utilization measurements we made during

testing. We estimate cooling costs equal to power costs.

* Forthe legacy solution, we assume the business purchases post-warranty hardware support each year from the

vendor for the servers and storage array. We include that in yearly costs, not acquisition costs.

* We also include estimates of the cost of additional downtime for the aging legacy servers. We estimate

negligible downtime for VRTX and 10 hours per server per year for the older legacy servers. We estimate the

cost of that downtime at $300 an hour assuming a number of users are affected each time one of the servers

becomes unavailable.

* Costs for the Dell PowerEdge VRTX solution also include staff costs for the Dell PowerEdge VRTX solution to

manage the VMware VSphere 5 virtualization.

Dell PowerEdge VRTX solution cost

Figure 19 shows the costs we calculated for the Dell PowerEdge VRTX solution.

Dell PowerEdge VRTX with

two Dell PowerEdge M630 Unit Cost p er Quantity description Quantity Total cost
server nodes unit
Acquisition costs
Hardware

Platform (after One VRTX including
Dell PowerEdge VRTX platform 29% discount) $20,515 five-year support 1 $20,515
Dell PowerEdge M630 Blade N.ode (after 29% 47,488 Qne node including ) $14,977
Server discount) five-year support
Software licenses

Each server with
Windows Server 2012 R2 up to two Two servers with two
Standard Edition (processor + | processors. Up to $883 | processors each (max 2 $1,766
CAL licensing) two VMs per two VMs per server)

license.
Microsoft SQL Server 2012 R2 One license per One SQL Server VM
Standard (server + CAL QL VM S898 | per legacy SQL server 1 5898
licensing) we consolidate
Microsoft Exchange Server One license per Two Exchange VMs
2013 Standard Edition (server S708 | per legacy Exchange 2 $1,416

. i Exchange VM .

+ CAL licensing) server we consolidate
VMware vSphere 5 Standard One per processor $995 | Number processors 4 $3,980
for one processor
Setup Cost per hour $56 | Number hours 8 $449
Total acquisition costs $44,000
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Dell PowerEdge VRTX with

two Dell PowerEdge M630 Unit Cost p er Quantity description Quantity Total cost
server nodes unit
Annual costs
Software support
Windows Server 2012 Each server with Two servers with two
Standard Edition (Software up to two $221 | processors each (max 2 S442
Assurance) processors two VMs per server)
Microsoft SQL Server 2012 One license per $225 ngI:;LC\S/eSr(\;irs\e{:\\//ler 1 $225
Standard (Software Assurance) | SQL VM .

we consolidate
Microsoft Exchange Server One server S177 ;\évroltf;:?\?:iih\g:\ﬂgse 2 $354
2013 (Software Assurance) .

server we consolidate
VMyvare vSphere 5 Standard One per processor $273 | Number processors 4 $1.092
Basic support per year
Energy cost for power and Platform $725 | One VRTX 1 $725
cooling
Hardware management Cost per hour $56 | Number hours 12 S673
VMware management Cost per hour $56 | Number hours 24 $1,346
Total annual costs $4,857
Average cost per month $405

Figure 19: Cost analysis for the Dell PowerEdge VRTX with two Dell PowerEdge M630 server nodes. (Totals may not sum due to

rounding.)

Legacy solution costs

Figure 20 shows the costs we calculated for the legacy solution.

Legacy costs Unit Co::ﬁ;:er Quantity description | Quantity Total cost
Acquisition costs
Software licenses

Each server with
Windows Server 2012 up to two Three servers with
Standard Edition (processor processors. Up to $883 | one or two processors 3 $2,649
licenses) two VMs per each

license.
Microsoft SQL Server.2012 One server 4898 Qne server with SQL 1 4898
Standard (processor licenses) installed
Microsoft Exchange Server One Server with
2013 Standard (server One server $658 1 $658
. Exchange
licenses)
Setup

Cost per hour S56 | Number hours 16 | $897
Total acquisition costs $5,102

Annual costs
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Legacy costs Unit Co::li;:er Quantity description Quantity Total cost
Support
Windows Server 2012 Each server with Three servers with
Standard Edition (Software up to two $221 | one or two processors 3 $663
Assurance) processors each
Microsoft SQL Server 2012 )
Standard (Software One server $165 _One server with SQL 1 $165
installed
Assurance)
Microsoft Exchange 2013 One server with
Standard (Software One server S165 1 S165
Exchange
Assurance)
HP extended
support
Hardware support agreements for $3,091 | One year 1 $3,091
three servers and
storage array with
one-year terms
Energy cost for power and
cooling
$1,269 | One year 1] $1,269
Hardware management
Estimate at two hours
Per solution g50 | @ month per server + 84 $4,200
one hour a month for
storage array per year
Downtime cost
Per ho.ur 4300 Each.server down for 30 $9.000
downtime cost multiple hours a year
Legacy annual costs $18,553
Average cost per month $1,546

Figure 20: Cost analysis for the legacy solution. (Totals may not sum due to rounding.)
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